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Session 2

On an Alien Planet

M

In this session, students continue animating their space adventure. They create
two scenes using frame by frame animation. To start, they create the planet
surface that shows grass growing and a flower blooming. Afterwards, they
apply their new skills to make a hover craft drive over bumpy terrain. The
session ends with students selecting an Animation Challenge and creating it
using Frame by Frame Animation.
Assignment 11: What Is Frame by Frame Animation?

SA

Assignment 12: Create Scene 2 – The Planet
Assignment 13: Create Scene 3 – The Hover Craft
Assignment 14: Frame by Frame Challenge
Session 2 Review: About Frame by Frame Animation
Session 2 Skill Review: Animate a Dog's Tail Wagging
Session 2 Extension Activity: Using Layers

Session 2: On an Alien Planet
Getting Started
Overview

E

In this session, students continue animating their space adventure. They create two scenes using
frame by frame animation. To start, they create the planet surface that shows grass growing and
a flower blooming. Afterwards, they apply their new skills to make a hover craft drive over
bumpy terrain. The session ends with students selecting an Animation Challenge and creating it
using Frame by Frame Animation.
Materials
Animate CC

•

Scene 2 sample

•

Scene 3 sample

•

Sign sample

•

Wave sample

•

Workbook folder with individual worksheets

•

Session 2 Review: About Frame by Frame Animation

•

Session 2 Skill Review: Animate a Dog's Tail Wagging
o

Tail sample

Teacher Preparation

PL

•

M

(Refer to the Preparing to Teach section of this guide for instructions)
•

Make the Animate folder available to students.

Teaching Strategy

In this session, students learn about frame by frame animation. Explain scenario to students.

SA

In this session, you are going to animate using frame by frame
animation. Frame by frame animation is used to move an object from
one position to another, by creating content in EVERY frame. Although
creating this type of animation does take time, it is a great way to gain
control over how an object will move across the stage.
Let's create the way animators did in the past, by creating an animated sequence one
frame at a time. To become good at making frame by frame animation you need to
create it more than once. For this reason, you will animate grass growing, hover craft
driving, flashing sign, and waving creature.
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Assignment 11 What Is Frame by Frame Animation?
In this assignment, students learn about frame by frame animation. This type of animation places
content in EVERY frame of the Timeline in a keyframe. To gain an understanding of how each
frame has different content, students study sample videos to notice the use of frame by frame
animation.
Emphasize the difference between a keyframe and a blank keyframe. A blank keyframe does
not copy the content of the previous frames and is empty. A keyframe does copy the content of
the previous frames.

Frame by Frame Animation: Frame by frame animation has the content of every frame
change, by placing content in every frame of the Timeline into a keyframe.

PL

•

E

Introduce the following terminology:

Assignment 12 Create Scene 2 – The Planet

In this assignment, students create a scene that has the alien standing on his planet with the
grass growing and flowers blooming. The action is created using frame by frame animation. You
may wish to model the steps of making a frame by frame animation before students begin the
assignment.
Assignment 13 Create Scene 3 – The Hover Craft

M

In this assignment, students create a scene that has a hover craft drive over bumpy terrain. You
may wish to review the steps of making frame by frame animation before students begin the
assignment.
Assignment 14 Frame by Frame Animation Challenge

SA

This is an optional assignment. Students should complete this assignment, based on their needs. If
time is a factor, then this assignment can be skipped. However, if students are struggling to
understand frame by frame animation, or are looking for an extra challenge, this assignment
offers two fun activities. One is a sign with letters that change color, and the other is a rock
creature that waves at the hover craft.
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Lesson Plan
Assignment 11 - What Is Frame by Frame Animation?
•

Read about frame by frame animation and then answer questions.

•

Study frame by frame animation by viewing a sample.

Assignment 12 - Create Scene 2 – The Planet
Open the Animate document.

•

Insert a new scene. View the scenes in the document.

•

Insert the alien from the Library onto the stage for Scene 2.

•

Animate the Ground: Draw a short line using the Pencil Tool, to make a portion of the
ground. Insert a keyframe into Frame 6. Draw another short line and add another
keyframe. Continue until the ground stretches across the stage.

•

Draw the Grass: Draw the blade of grass using the Pencil Tool. Insert a keyframe into the
frame beside the last keyframe in the Timeline. Draw another blade of grass and insert
another keyframe in the next frame. Continue to draw blades of grass and add
keyframes until the grass reaches across the entire stage.

•

Draw a Flower Blooming: Use frame by frame animation to draw a flower stem, leaf, and
petals, with each appearing one after the other in its own keyframe.

•

Add the text to describe the action.

•

Solve the problem of how to make the words appear at the SAME TIME as the action
(Solution: place it on its own layer). Insert a new layer and rename it Words. Cut the
words from Layer_1 and paste them onto the Words layer.

•

Save the Animate document and then close the program.

PL

E

•

Assignment 13 - Create Scene 3 – The Hover Craft
Open the Animate document.

•

Insert a new scene.

•

Rename Layer_1 to Hover Craft.

•

Draw the planet surface.

•

Draw the hover craft and group the object.

•

Animate the hover craft using frame by frame animation to have it drive over the bumpy
terrain by moving up and down across the stage.

•

Add words to describe the action on a new layer.

•

View the story.

•

Save the Animate document and then close the program.

SA

M

•

Assignment 14 - Frame by Frame Animation Challenge
•

Open the Animate document and display Scene 3.

•

Select from two challenges: planet sign or waving rock creature.

•

Save the Animate document and then close the program.
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Learning Objectives
Students should be able to complete each learning objective independently.
Content Knowledge:
 define frame by frame animation
 understand the difference between a blank keyframe and keyframe
Technical Skills:

E

Operating Environment
 open and close a program
 save a document

PL

Animation
 insert a new scene
 view scenes in a document
 insert an object from the symbol Library
 select a frame
 insert a keyframe
 animate an object using frame by frame animation
 view the animation using the ENTER key
 insert and rename a layer
 cut an object
 paste an object in the same position as the copied item using Paste in Place
 test the movie in the preview window
Graphics
 add text and customize the properties
 draw objects and customize their appearance

SA

M

Applied Technology
 analyze frame by frame animation within a movie clip
 animate a space adventure using frame by frame animation
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Assignment 11 What Is Frame by Frame Animation?
In this session, you are going to animate using frame by frame animation. Frame
by frame animation is used to move an object from one position to another, by
creating content in every frame. Although creating this type of animation does
take time, it is a great way to gain control over how an object will move across
the stage. In this assignment, you will read about frame by frame animation
and view sample videos.
What Is Frame by Frame Animation?

PL

E

Frame by frame animation uses keyframes in EVERY frame of the Timeline. A keyframe copies the
content from the previous keyframe. The keyframes in frame by frame animation are placed
right beside each other. Slight changes are then made to the objects in each frame. These
changes are seen as movement when the animated sequence is played.

In frame by frame animation, a keyframe is
placed into every frame of the Timeline.

M

Frame by frame animation is a lot like what animators used to do in the past. Before there were
computers, animators used to draw the character in a new position, one frame at a time. To
create animation using this technique is a time-consuming task, however, it does offer lots of
control over how the object moves.

Questions about Frame by Frame Animation
What is frame by frame animation?

SA

1.

2.

Frame by frame animation uses keyframes. How is a keyframe different from a blank
keyframe?

Copyright © TechnoKids Inc.
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Study the Frame by Frame Animation Samples
View two sample videos created using frame by frame animation. One is of an alien landscape
with an animated planet surface. The second is of a flying hover craft. Afterwards, answer the
questions about frame by frame animation.
 Access the Animate folder. Open the Scenes folder.
The Alien
 Double click the Scene 2 file to watch the animated scene.

E

What different events occur in each frame of the animation?

 Close the file.
The Hover Craft

PL

3.

M

 Double click the Scene 3 file to watch the animated scene.

How would you describe the animation of the hover craft in this scene?

SA

4.

 Close the file.
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Assignment 12 Create Scene 2 – The Planet
In this assignment, you will create Scene 2 in your space adventure using frame
by frame animation. Use your skills to draw the planet surface. Follow the
instructions to animate the ground appearing, grass growing, and flower
blooming.
View a Sample Scene
 Access the Animate folder. Open the Scenes folder.

E

 Double click the Scene 2 file to watch a sample from an animated story.

PL

Please note, the sample
includes sound, which is
a feature that will be
added to the Timeline in
Session 6.

Open the Animate Document

 Open the document in the Animate program. The document opens to show the last
scene you were editing. In this case, the scene in view should be Scene 1.
Insert a New Scene

M

When making an animated story with the Animate program it is a good idea to divide the
events into scenes. Each scene has its own stage, Timeline, and layers.
 From the Insert menu, select Scene.

A new stage opens in the window. It has an empty Timeline. You will notice that the
Scene Number reads Scene 2.
If you cannot see the
Scene Number, select
Edit Bar from the
Window menu.

SA

−

View Each Scene in the Story

 Scene 1 has not been deleted. It is still part of the animated story. You can easily switch
from Scene 2 to Scene 1 and back again. Try it!
 Click Edit Scene on the Edit Bar. From the list click Scene 1.
 Click Edit Scene again and this time select Scene 2.

Some pages have been removed from this sample.
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Insert the Alien Symbol from the Library
In the previous session, you created an alien and placed it into the Library. The Library lets you
use the same object repeatedly without needing to redraw it. Insert the alien from the Library.
 From the Window menu, select Library.

E

 Click on the alien symbol and drag it onto the stage.

 Deselect the alien by pressing ESC on the keyboard.

PL

Animate the Ground Using Frame by Frame Animation

You are going to have the ground gradually appear underneath the alien
using frame by frame animation. Unlike the previous session when you used
blank keyframes, you are going to use keyframes. The difference between the
two is that a keyframe copies the content of the previous frames into the new
one. This means everything you drew before the keyframe remains on the
stage, whereas a blank keyframe is empty.
 From the Tools Panel, select the Pencil Tool.

SA

M

 From the Properties tab, select a stroke color, weight, and style.

 Turn object drawing mode OFF.
 Pick the type of line from the Tool Options in the Tools Panel. HINT: Try Smooth.

 Starting from the left side of the stage, draw a short line.

Draw a short line
for the ground.

Some pages have been removed from this sample.
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Assignment 13 Create Scene 3 – The Hover Craft
In this assignment, you will create Scene 3 in your space adventure using frame
by frame animation. Use your skills to draw a hover craft. Follow the instructions
to animate it driving over bumpy terrain.
View a Sample Scene
 Access the Animate folder. Open the Scenes folder.
 Double click the Scene 3 file to watch a sample from an animated story.

PL

E

Please note, the sample
includes sound, which is a
feature that will be added to
the Timeline in Session 6.

Open the Animate Document

 Open the document in Animate CC. The document opens to show the last scene you
were editing. In this case the scene in view should be Scene 2.
Insert a New Scene and Rename Layer 1

 From the Insert menu, select Scene.

 A new stage opens in the window. It has an empty Timeline. You will notice that the
Scene Number reads Scene 3.

M

 Double click Layer_1 and name it Hover_Craft. Press ENTER.

Draw a Bumpy Planet Surface

On the Hover Craft layer, draw a bumpy planet surface. Be creative! If you need help, follow
these instructions:
 From the Tools Panel, select the Rectangle Tool.

SA

 Turn object drawing mode OFF.
Select the SAME stroke
and fill color.
 Draw a rectangle.

 From the Tools Panel, select the Pencil Tool.
 Turn object drawing mode OFF.
Change the stroke color to the SAME color as the rectangle.
 Place the pencil on the edge of the rectangle and start to draw a bumpy line. End the
line by touching the edge of the rectangle.
 From the Tools Panel, select the Paint Bucket Tool.
gap size in the Options Tray. Fill the area with color.

Copyright © TechnoKids Inc.
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Draw a Hover Craft and Group All the Objects Together
 Use your skills to create a vehicle that drives across the planet surface.
 From the Tools Panel, click the Selection Tool.
 Click and drag around the hover craft.

E

The object must be
grouped to move it
across the stage.

 From the Modify menu, select Group.

Animate the Hover Craft Using Frame by Frame Animation

 Drag the hover craft to its starting point on Frame 1. Put it slightly off the stage.

PL

 Right click on Frame 2 in the Timeline. From the menu select Insert Keyframe or press F6
on the keyboard.
 Click on the stage to deselect all objects.

 Click on the hover craft to select it. Make sure the terrain is not selected.

 Use the arrow keys on the keyboard to move the hover craft a little up and towards the
other edge of the stage.
 Add a keyframe to Frame 3. Click on the hover craft to select it. Move it slightly down
and towards the other edge of the stage.

M

 Continue to add keyframes and move the hover craft slightly until it is off the other side of
the stage. It should look as if it is driving over the bumpy terrain.
 Use your skills to view the animation.

Add Words on a New Layer to Describe the Action
 Click New Layer
at the bottom of the Layers area of the Timeline.
Rename the new layer Words.

SA

 On the Words layer, click on Frame 1.
 Use the Text Tool

to type the words:

He got into his hover craft and drove to the launch pad.

Test the Scene

 From the Control menu select Test Scene.
Watch the hover craft fly across the planet surface.
 Click the Close button on the Test window pane to exit the preview.

Save the Animate Document and Close the Program
Copyright © TechnoKids Inc.
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Assignment 14 Frame by Frame Animation Challenge
You have learned how to animate objects using frame by frame animation. In
this assignment are two animation challenges. You can add a flashing sign or a
waving rock creature to Scene 3. Pick a challenge to practice your new skills.
Animate a Flashing Sign
1.

Access the Animate folder. Open the Challenges folder.
View the Sign file to watch a sample video.

E

The animated sign has letters
that change color one letter
at a time.

2.

Open the space adventure in Animate CC. View Scene 3.

3.

Click New Layer

4.

Draw a sign using the drawing tools.

PL

at the bottom of the Layers area. Rename the layer Sign.

TIP: The landscape, hover craft, or words might be in your way. You may want to temporarily
hide
a layer, such as the Hover Craft or Words layer, while drawing.

5.

Use the Text Tool

6.

Right click on the text box. Select Break Apart to ungroup the name
into individual letters.

7.

Place a keyframe in Frame 2 of the Sign layer. Select Frame 2. From the Insert menu,
select Timeline and then Keyframe, or press F6 on the keyboard.

M
Change the first letter to another color:
a.

Click on the stage to deselect all objects.

b.

Select the first letter using the Selection Tool.

c.

Select a color from the Fill Control.

SA

8.

to add the planet name to the sign.

9.

Place a keyframe in Frame 3 of the Sign layer.

10.

Deselect all objects. Change the next letter to another color.

11.

Continue to add keyframes and change the letter color until all letters have changed.

12.

Copy the animation you have just created to have it repeat itself:
a.
b.
c.
d.

Click on the last keyframe in the Sign layer. Hold the SHIFT key and click Frame 1.
Right click on the selected frames and select Copy Frames from the menu.
Right click inside the next blank frame in the Sign layer. Select Paste Frames.
Click away from the frame or timeline to see the pasted frames.
You can keep pasting the frames, by right clicking on the next blank frame and
then selecting Paste Frames from the menu.

TIP: Does the sign display longer than the Hover Craft and Word layers? To solve this problem,
select the frames in the Sign layer. Right click on the selection and select Remove Frames.

Copyright © TechnoKids Inc.
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Session 2 Review: About Frame by Frame Animation
Match the tool to its function.
A.

Display objects on a layer as solid or an outline.

2.

B.

Add a layer.

3.

C.

Select a scene to edit.

4.

D.

Show or hide a layer.

PL

E

1.

5.

E.

Lock or unlock a layer.

/5

Match the term to its definition.

7.

frame by frame animation

A.

A gallery of stored objects

M

6.

scene

B.

Animation that has a keyframe in every frame

Timeline

C.

A part of an Animate document that contains
its own stage, Timeline, and layers

keyframe

D.

A frame in an animated sequence that
contains drawn objects

10.

Library

E.

Made up of layers and frames, it organizes and
controls a document's content over time

11.

frame

F.

A single unit in a Timeline

12.

layer

G.

A division of the Timeline into parts that allow
objects to be stacked on top of each other

8.

SA

9.

/7

Some pages have been removed from this sample.
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Session 2 Skill Review: Animate a Dog's Tail Wagging
Frame by frame animation can be used to animate objects one frame at a time using
keyframes. In this assignment, you apply your knowledge to create a dog with a wagging tail.
1.

Access the Animate folder. Open the Skill Reviews folder.
View the Tail file to watch a sample video.

E

Animate the tail to move
back and forth. Use your skills
to copy and paste frames to
make it repeatedly wag.

Open Animate. Select ActionScript 3.0.

3.

Rename Layer_1 to Dog.

4.

Draw a creature using the drawing tools. DO NOT INCLUDE A TAIL.

5.

Group the creature:

PL

2.

a.

Select the Selection Tool.

b.

From the Modify menu, click Group.

Click and drag to draw a box around the dog.

Position the dog on the stage.

7.

Draw a tail. If the parts of the tail are not grouped, group them.

8.

Position the tail so it looks like it is attached to the creature. If necessary, change the
object order. Right click the tail. From the menu, select Arrange. Click Send to Back.

9.

Place a keyframe in Frame 2 of the Dog layer. Select Frame 2. From the Insert menu,
select Timeline and then Keyframe, or press F6 on the keyboard.

10.

Move the registration point to set how the tail pivots:

M

6.

a.

Click the Free Transform Tool.

b.

If necessary, click on a blank area of the stage to deselect all objects.

c.

Click on the tail to select it. Click on the registration point - it
is the round circle inside the bounding box.

d.

Drag it to the point where the tail should pivot. (at the body)

Rotate the tail slightly.

12.

Place a keyframe in Frame 3.

13.

Deselect all objects. Rotate the tail a bit more.

14.

Continue to add keyframes until the tail has moved in one direction.

15.

Copy the animation you have just created to have it repeat itself:

SA

11.

a.
b.
c.
d.

16.

Click on the last keyframe in the Dog layer. Hold the SHIFT key and click Frame 1.
Right click on the selected frames and select Copy Frames from the menu.
Right click inside the next blank frame in the Dog layer. Select Paste Frames.
You can keep pasting the frames, by right clicking on the next blank frame and
then selecting Paste Frames from the menu.

17.

View the animation. IF you find the tail moves too fast, adjust the frames per second. In
the Properties panel, click FPS (frames per second). Change the number to 12 fps.
Save the file as tail.

18.

Close the Animate Program.
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Session 2 Extension Activity: Using Layers
In this extension activity, you will explore the Layers area. Learn how to insert,
rename, move, hide, lock, view, and delete layers.
What Is a Layer?
The Layers panel is part of the Timeline. A layer is a row in a Timeline. It is used to organize parts of
a scene. By placing objects on different layers, it is possible to have several animations appear
at the same time.

E

Layers are used to:
organize a scene into manageable parts

•

adjust the stacking order of objects on the stage

•

display objects as outlines

•

temporarily hide objects to declutter the stage

•

structure animated sequences

•

navigate to a keyframe quickly

•

add a camera view

•

create depth on the stage

About the Layers Panel

PL

•

The layer area of the Timeline has tools for managing layers. Read to learn about each part:
New Layer: Insert a new layer on the Timeline.

M

New Folder: Create a folder to group layers.
Delete: Remove a layer from the Timeline.

Add Camera: Add a camera layer to pan and zoom the stage.
Layer Depth Panel: Create depth on the stage.
Parenting View: Connect layers or objects to control movement.

SA

Show or Hide Layers: Display or temporarily remove a layer from view.
Lock or Unlock Layers: Permit or prevent edits to a layer.
Show Layer as Outline: Display objects as solid or black and white line
drawings.

1.

Open Animate. Select ActionScript 3.0.

2.

Rename a layer:

a.

Double click on Layer _1.

b.

Type Circle. Press the ENTER key.

Some pages have been removed from this sample.
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